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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Product Name HP Pavilion dv6 Notebook PC √ √

Processors AMD® A8-3530MX 2.60-GHz processor, (1.90-GHz
FSB, 4.0-MB L2 cache, quad core, 45 W)

√  

 AMD A8-3510MX 2.50-GHz processor (1.50-GHz
FSB, 4.0-MB L2 cache, quad core, 45 W)

√  

 AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√  

 AMD A6-3410MX 2.30-GHz processor (1.60-GHz
FSB, 2.0-MB L2 cache, quad core, 45 W)

√  

 AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB,
4.0-MB L2 cache, quad core, 35 W)

√  

 AMD A4-3310MX 2.50-GHz processor (2.10-GHz
FSB, 2.0-MB L2 cache, dual core, 45 W)

√  

 AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB,
4.0-MB L2 cache, dual core, 35 W)

√  

 Intel® Core® i7-2860QM 2.50-GHz (SC turbo up to
3.60-GHz) processor (1600-MHz FSB, 8.0-MB L3
cache, dual core, 45 W)

 √

 Intel Core i7-2820QM 2.30-GHz (SC turbo up to
3.20-GHz) processor (1600-MHz FSB, 8.0-MB
L3 cache, quad core, 45 W)

 √

 Intel Core i7-2760QM 2.40-GHz (SC turbo up to
3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, dual core, 45 W)

 √

 Intel Core i7-2720QM 2.20-GHz (SC turbo up to
3.00-GHz) processor (6.0-MB L3 cache,
quad core, 45 W)

 √

 Intel Core i7-2670QM 2.20-GHz (SC turbo up to
3.10-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, dual core, 45 W)

 √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-
GHz) processor (1333-MHz FSB, 4.0-MB L3 cache,
dual core, 35 W)

 √

 Intel Core i7-2630QM 2.00-GHz (SC turbo up to
2.90-GHz) processor (1333-MHz FSB, 6.0-MB
L3 cache, quad core, 45 W)

 √

 Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-
GHz) processor (4.0-MB L3 cache, dual core, 35 W)

 √

 Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

 √

 Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

 √

 Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

 √

 Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3
cache, dual core, 35 W)

 √

 Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3
cache, dual core, 35 W)

 √

 Intel Pentium® B960 TJ85 2.20-GHz processor (2.0-
MB L3 cache, dual core, 35 W)

 √

 Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB
L3 cache, dual core, 35 W)

 √

Chipset Northbridge: AMD A70M Fusion controller hub (FCH)

Northbridge: AMD A60M FCH

Southbridge: AMD SB820M

√  

 Intel HM65 Express chipset with NEC USB 3.0 (select
models only)

 √

 Intel HM65 Express chipset  √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Graphics Internal graphics:

● AMD Radeon™ HD 6620G graphics on
computer models equipped with an AMD
A8 processor

● AMD Radeon HD 6520G graphics on computer
models equipped with an AMD A6 processor

● AMD Radeon HD 6480G graphics on computer
models equipped with an AMD A4 processor

Switchable discrete graphics:

● AMD Radeon HD 6755G2 graphics subsystem
on computer models equipped with an AMD A8
or A6 processor, with 1024-MB of dedicated
video memory (64-MB × 16 GDDR5 × 8 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB
× 32 with 5GBPS capability

● AMD Radeon HD 6750M graphics subsystem on
computer models equipped with an AMD
A4 processor, with 1024-MB of dedicated video
memory (64-MB × 16 GDDR5 × 8 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB
× 32 with 5GBPS capability

● AMD Radeon HD 6645G2 graphics subsystem
on computer models equipped with an AMD
A8 processor, with 512-MB of dedicated video
memory (64-MB × 16 GDDR5 × 4 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB
× 32 with 5GBPS capability

● AMD Radeon HD 6545G2 graphics subsystem
on computer models equipped with an AMD
A6 processor, with 512-MB of dedicated video
memory (64-MB × 16 GDDR5 × 4 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB
× 32 with 5GBPS capability

● AMD Radeon HD 6515G2 graphics subsystem
on computer models equipped with an AMD
A4 processor, with 512-MB of dedicated video
memory (64-MB × 16 GDDR5 × 4 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB
× 32 with 5GBPS capability

√  

3



Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Internal graphics:

● Intel HD Graphics 3000 on computer models
equipped with an Intel Core i7, i5, or
i3 processor

● Intel HD Graphics 3000 on computer models
equipped with an Intel Pentium processor

Switchable discrete graphics:

● ATI XT Radeon HD 6770M M2 package with
2048-MB (64-MB × 32 GDDR5 × 8 PCs, 5GBPS)
or 1024-MB (32-MB × 32 GDDR5 × 8 PCs,
5GBPS) of graphics subsystem discrete memory,
muxless

● ATi XT Radeon HD 6490M M2 package with
1024-MB of graphics subsystem discrete memory
(64-MB × 32 GDDR5 × 4 PCs, 5GBPS), muxless

 √

 Support for DX11, HD decode, HDMI, BACO √ √

Panel 15.6-in, full high-definition (FHD), light-emitting diode
(LED), low-voltage differential signalling (LVDS), WVA
AntiGlare (1080p, 1900×1080) display; typical
brightness: 220 nits

15.6-in, HD, LED, LVDS, SVA BrightView (1366×768)
display; typical brightness: 200 nits

All display assemblies include 2 wireless local area
network (WLAN) antenna cables

Supports 16:9 ultra wide aspect ratio

Lighted logo on top bezel

√ √

Memory 2 customer-accessible/upgradable memory
module slots

√ √

 Supports dual-channel memory √ √

 Supports up to 8192 GB of system RAM √  

 Supports up to 16384 GB of system RAM  √

 DDR3/1333-MHz √ √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Supports the following configurations:

● 16384-MB total system memory (8192×2)

● 12288-MB total system memory (8192×1 +
4096×1)

● 8192-MB total system memory (8192×1 or
4096×2)

● 6144-MB total system memory (4096×1 +
2048×1)

● 4096-MB total system memory (4096×1 or
2048×2)

● 2048-MB total system memory (2048×1)

√ √

Hard drives Supports 6.35-cm (2.5-in) hard drives in 12.7-mm (.
50-in), 9.5-mm (.37-in), and 7.0-mm (.28-
in) thicknesses

√ √

 Customer-accessible √ √

 Accelerometer / HDD protection support √ √

 Serial ATA √ √

 Supports the following configurations:

● 1 TB, 5400 rpm (12.7 mm)

● 750 GB, 7200 and 5400 rpm (9.5 mm)

● 640 GB, 5400 rpm (9.5 mm)

● 500 GB, 7200 rpm (9.5 mm)

● 320 GB, 7200 and 5400 rpm (7.0 mm)

√ √

 Supports 160-GB solid-state drive  √

Optical drive Fixed √ √

 Serial ATA √ √

 12.7-mm tray load √ √

 Blu-ray Disc ROM FX SuperMulti DVD±R/RW Double-
Layer Drive

√ √

 Blu-ray Disc R/RW FX SuperMulti Drive  √

 DVD±RW Double-Layer FX SuperMulti Drive √ √

Audio and video Dual array digital microphones with appropriate beam-
forming, echo-cancellation, noise-suppression software

√ √

 HD audio √ √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 HP-branded Altec/Lansing quad Beats Audio speakers
(select models only)

√ √

 HP TrueVision HD webcamera (fixed, integrated, low-
light)

√ √

Ethernet Integrated 10/100/1000 network interface
card (NIC)

√ √

Wireless Integrated wireless local area network (WLAN) options
by way of wireless module

√ √

 Two WLAN antennas built into display assembly √ √

 Support for the following WLAN formats:

● Atheros 9485GN 802.11b/g/n 1×1 WiFi and
3012 Bluetooth 4.0 Combo Adapter

● Broadcom 4313 802.11b/g/n 1×1 WiFi and
2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

● Broadcom 4313GN 802.11b/g/n 1×1 WiFi
and 20702 Bluetooth 4.0 Combo Adapter

● Ralink 5390GN 802.11b/g/n 1×1
WiFi Adapter

● Realtek RTL8191SE 802.11b/g/n 1×1
WiFi Adapter

√ √

 Support for the following WLAN formats:

● Atheros AR8002WB-1NGB 802.11b/g/n 1×1
WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

√  

 Support for the following WLAN formats:

● Broadcom 4313 802.11b/g/n 1×1
WiFi Adapter

● Intel Centrino Advanced-N 6230 WLAN module

● Intel Centrino Wireless-N 1000 WLAN module

● Intel Centrino Wireless-N + WiMAX 6150
WLAN module

● Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and
Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

 √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

External media
card

HP Multi-Format Digital Media Reader supports the
following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital Extended Capacity (SDxC)
Memory Card

● Secure Digital High Capacity (SDHC)
Memory Card

● Ultra High Speed MultiMediaCard (UHS/MMC)

√ √

Ports ● 3-pin AC power

● Audio-in (mono microphone)

● Audio-out (stereo headphone; 2)

● HDMI version 1.4 supporting up to 1920 ×1200
@ 60Hz

● RJ-45 (Ethernet, includes link and activity lights)

● USB 2.0 (3 ports)

● VGA (Dsub 15 pin) supporting 2048×1536
external resolution @ 75 Hz hot plug and unplug
and auto-detection for correct output to wide-
aspect vs. standard aspect video

√ √

Keyboard/
pointing devices

Full-size (15.6-in), textured, keyboard with
numeric keypad

√ √

 TouchPad with multi-touch gestures, 2-finger scrolling,
and pinch-zoom enabled

√ √

 Dura-coat, island-style keyboard √ √

 Multitouch gestures (2-finger scrolling and pinch-zoom)
enabled by default

√ √

 Taps enabled by default √ √
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Power
requirements

Support for the following 3-wire plug with
ground pin AC adapters (supports 3-
pin DC connector):

● 120W AC adapter with localized cable
plug support

● 90W EM AC adapter with localized cable
plug support

● 90W AC adapter with localized cable
plug support

● 65W EM AC adapter with localized cable
plug support

● 65W AC adapter with localized cable
plug support

√ √

 Support for the following batteries:

● 9cell, 100-Whr, 3.00-Ah Li-ion battery

● 6-cell, 62-Whr, 2.80-Ah Li-ion battery

● 6-cell, 55-Whr, 2.55-Ah Li-ion battery

√ √

Security Security cable slot √ √

 Fingerprint reader with Digital Persona
software support (select models only)

 √

 Support for Intel AT-p Ready  √

Operating
system

Preinstalled:

● Windows 7 Home Basic (select models only)

● Windows 7 Home Premium 64-bit (select
models only)

● Windows 7 Professional 64-bit (select
models only)

√  
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Category Description Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

 Preinstalled:

● Windows 7 Home Basic (64- and 32-bit; select
models only)

● Windows 7 Home Premium (64- and 32-bit;
select models only)

● Windows 7 Professional (64- and 32-bit; select
models only)

● Windows 7 Starter (32-bit; select models only)

● Windows 7 Ultimate (64-bit; select models only)

● FreeDOS

● RedFlag

 √

Serviceability End-user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Memory modules (2)

● Optical drive

● WLAN module

√ √
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2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs.

(2) Internal microphones (2) Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam Records video and captures still photographs.

To use the webcam, select Start > All Programs >
CyberLink YouCam > CyberLink YouCam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Buttons, speakers, and fingerprint reader (select
models only)

Item Component Description

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press the
button briefly to exit Sleep.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options, or refer to the HP Notebook Reference Guide.

(2) Speakers (2) Produce sound.

(3) Web browser button Opens the default Web browser.

(4) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a
password logon.

Buttons, speakers, and fingerprint reader (select models only) 11



Keys

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with the num lk key, the b key, or the
esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) b key Increases or decreases the Beats Audio bass settings
(select models only). Beats Audio is an enhanced audio
profile that provides a deep, controlled bass while
maintaining a clear sound. Beats Audio is enabled
by default.

You can also view and control the bass settings through
the Windows operating system. To view and control the
bass properties:

● Select Start > All Programs > Beats Audio
Control Panel > Listening Experience.

– or –

● Select Start > Control Panel > Hardware
and Sound > Beats Audio Control Panel >
Listening Experience.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.
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Item Component Description

(6) Integrated numeric keypad When the keypad has been enabled, the keys can be
used like an external numeric keypad.

(7) num lk key Enables/disables the integrated numeric keypad when
pressed in combination with the fn key.

(8) Action keys Execute frequently used system functions.

Lights

Item Component Description

(1) Caps lock light On: Caps lock is on.

(2) Power light ● White: the computer is on.

● Blinking white: the computer is in the Sleep state.

● Off: the computer is off or in Hibernation.

(3) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

Lights 13



Item Component Description

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(5) Fingerprint reader light (select models only) ● White: The fingerprint was read.

● Amber: The fingerprint was not read.

TouchPad

Item Component Description

(1) TouchPad off light ● On: The TouchPad is off.

● Off: The TouchPad is on.

(2) TouchPad on/off button Turns the TouchPad on and off.

(3) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) TouchPad on light ● On: The TouchPad is on.

● Off: The TouchPad is off.

(6) Right TouchPad button Functions like the right button on an external mouse.
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Front

Item Component Description

(1) Digital Media Slot Supports the following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital Extended Capacity (SDxC)
Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● Ultra High Speed MultiMediaCard (UHS/MMC)

(2) Speakers (2) (select models only) Produce sound.

Rear

Component Description

Vent Enables airflow to cool internal components.

NOTE: the computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

Front 15



Left side

Item Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: the computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

(2) External monitor port Connects an external VGA monitor or projector.

(3) HDMI port Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

(4) RJ-45 (network) jack Connects a network cable.

(5) USB ports (2) Connect optional USB devices.

NOTE: Depending on your computer model, your
computer may be equipped with 2 USB 3.0 ports, which
connect optional 3.0 devices and provide enhanced USB
power performance. USB 3.0 ports are also compatible
with USB 1.0 and USB 2.0 devices.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7) Audio-out (headphone) jacks (2) Produce sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices.

NOTE: When a device is connected to a headphone
jack, the computer speakers are disabled.
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Right side

Item Component Description

(1) Optical drive Reads and writes (select models only) to an optical disc.

(2) Optical drive light ● Green: The optical drive is being accessed.

● Off: The optical drive is off.

(3) Optical drive eject button Ejects the optical drive.

(4) Power light ● White: the computer is on.

● Blinking white: the computer is in the Sleep state.

● Off: the computer is off or in Hibernation.

(5) Drive light ● Blinking white: The hard drive is being accessed.

● Amber: HP ProtectSmart Hard Drive Protection has
temporarily parked the hard drive.

NOTE: For information on HP ProtectSmart Hard
Drive Protection, refer to the HP Notebook
Reference Guide.

(6) USB ports (2) Connect optional USB devices.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(8) Battery light ● White: the computer is connected to external power
and the battery is fully charged.

● Amber: A battery is charging.

● Blinking amber: The battery has reached a low
battery level, or there is a battery error. When a
battery reaches a critical battery level, the battery
light begins blinking rapidly.

(9) Power connector Connects an AC adapter.
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Bottom

Item Component Description

(1) Battery bay Holds the battery.

(2) Battery release latch Releases the battery from the battery bay.

(3) Vents (6) Enable airflow to cool internal components.

NOTE: the computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

(4) Hard drive bay Contains the hard drive, the WLAN device, and the
memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

Service tag 19



Item Component Description

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components

Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 30.

(2) Keyboard (includes keyboard cable):

Computer major components 21



Item Component Spare part number

 Keyboard in black finish:

 For use with all computer models in Belgium 665326-A41

 For use with all computer models in Brazil 665326-201

 For use only with computer models equipped with an AMD processor in Bulgaria 665326-261

 For use with all computer models in Canada 665326-121

 For use with all computer models in the Czech Republic and Slovakia 665326-FL1

 For use with all computer models in Denmark, Finland, and Norway 665326-DH1

 For use with all computer models in France 665326-051

 For use with all computer models in Germany 665326-041

 For use with all computer models in Greece 665326-DJ1

 For use with all computer models in Hungary 665326-211

 For use only with computer models equipped with an Intel processor in India 665326-D61

 For use only with computer models equipped with an Intel processor in Israel 665326-BB1

 For use with all computer models Italy 665326-061

 For use with all computer models in Japan 665326-291

 For use with all computer models in Latin America 665326-161

 For use with all computer models in the Netherlands 665326-B31

 For use with all computer models in Portugal 665326-131

 For use with all computer models in Russia 665326-251

 For use with all computer models in Saudi Arabia 665326-171

 For use with all computer models in Slovenia 665326-BA1

 For use only with computer models equipped with an Intel processor in South Korea 665326-AD1

 For use with all computer models in Spain 665326-071

 For use with all computer models in Switzerland 665326-BG1

 For use only with computer models equipped with an Intel processor in Taiwan 665326-AB1

 For use only with computer models equipped with an Intel processor in Thailand 665326-281

 For use with all computer models in Turkey 665326-141

 For use with all computer models in the United Kingdom and Singapore 665326-031

 For use with all computer models in the United States 665326-001

 Keyboard in silver finish:

 For use with all computer models in Belgium 666423-A41

 For use with all computer models in Brazil 666423-201
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Item Component Spare part number

 For use only with computer models equipped with an AMD processor in Bulgaria 666423-261

 For use with all computer models in Canada 666423-121

 For use with all computer models in the Czech Republic and Slovakia 666423-FL1

 For use with all computer models in Denmark, Finland, and Norway 666423-DH1

 For use with all computer models in France 666423-051

 For use with all computer models in Germany 666423-041

 For use with all computer models in Greece 666423-DJ1

 For use with all computer models in Hungary 666423-211

 For use only with computer models equipped with an Intel processor in India 666423-D61

 For use only with computer models equipped with an Intel processor in Israel 666423-BB1

 For use with all computer models Italy 666423-061

 For use with all computer models in Japan 666423-291

 For use with all computer models in Latin America 666423-161

 For use with all computer models in the Netherlands 666423-B31

 For use with all computer models in Portugal 666423-131

 For use with all computer models in Russia 666423-251

 For use with all computer models in Saudi Arabia 666423-171

 For use with all computer models in Slovenia 666423-BA1

 For use only with computer models equipped with an Intel processor in South Korea 666423-AD1

 For use with all computer models in Spain 666423-071

 For use with all computer models in Switzerland 666423-BG1

 For use only with computer models equipped with an Intel processor in Taiwan 666423-AB1

 For use only with computer models equipped with an Intel processor in Thailand 666423-281

 For use with all computer models in Turkey 666423-141

 For use with all computer models in the United Kingdom and Singapore 666423-031

 For use with all computer models in the United States 666423-001

(3) Top cover (includes TouchPad and TouchPad button board, but does not include TouchPad cable or TouchPad
button board cable):

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit, spare part number
665301-001.

 In butter gold finish 665364-001

 In dark umber finish 665356-001

 In espresso black finish 665358-001
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Item Component Spare part number

 In linen white finish 665359-001

 In Pacific blue finish 665360-001

 In pearl pink finish 665363-001

 In ruby red finish 665362-001

 In Sonoma red finish 665361-001

 In steel gray finish 665357-001

(4) Power button board (does not include cable)

NOTE: The power button board cable is not included in the power button board
spare part kit. The power button board cable is included in the Cable Kit, spare part
number 665301-001.

665330-001

(5) Fingerprint reader board (select models only, includes bracket, but does not
include cable)

NOTE: The fingerprint reader board cable is not included in the fingerprint reader
board spare part kit. The fingerprint reader board cable is included in the Cable Kit,
spare part number 665301-001.

665310-001

(6) EDR v.4.0 Bluetooth module (for use only with computer models equipped with
an Intel processor)

NOTE: The Bluetooth module spare part kit does not include the Bluetooth
module cable. The Bluetooth module cable is available using spare part number
665303-001.

655792-001

(7) Bluetooth module cable (for use only with computer models equipped with an
Intel processor)

665303-001

(8) USB board (does not include cable)

NOTE: The USB board cable is not included in the USB board spare part kit. The
USB board cable is included in the Cable Kit, spare part number 665303-001.

665331-001

 Cable Kit, includes: 665301-001

(9a) Optical drive connector cable

(9b) Hard drive connector cable

 Not illustrated:

 Power button board cable

 Fingerprint reader board cable

 TouchPad cable

 TouchPad button board cable

 USB board cable

 NOTE: See Cable Kit on page 29 for more Cable Kit spare part information.

(10) Power connector cable 665306-001

(11) Speaker cover 665333-001
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(12) Speaker Kit (includes left and right speakers and cable) 665340-001

(13) System board (includes replacement thermal material):

 For use only with computer models equipped with an AMD A70M processor, the
HD6750 graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665284-001

 For use only with computer models equipped with an AMD A70M processor, a
graphics subsystem with UMA memory, and USB version 3.0

665282-001

 For use only with computer models equipped with an AMD A60M processor, the
HD6750 graphics subsystem with 1024-MB of discrete memory, and USB version 2.0

665281-001

 For use only with computer models equipped with an AMD A60M processor, the
HD6490 graphics subsystem with 512-MB of discrete memory, and USB version 2.0

665280-001

 For use only with computer models equipped with an AMD A60M processor, a
graphics subsystem with UMA memory, and USB version 2.0

665279-001

 For use only with computer models equipped with an Intel quad core processor, the
HD6770 graphics subsystem with 2048-MB of discrete memory, and USB version 3.0

665342-001

 For use only with computer models equipped with an Intel dual core processor, the
HD6770 graphics subsystem with 2048-MB of discrete memory, and USB version 3.0

665341-001

 For use only with computer models equipped with an Intel quad core processor, the
HD6770 graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665344-001

 For use only with computer models equipped with an Intel dual core processor, the
HD6770 graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665343-001

 For use only with computer models equipped with an Intel quad core processor, the
HD6490 graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665348-001

 For use only with computer models equipped with an Intel quad core processor, the
HD6490 graphics subsystem with 1024-MB of discrete memory, and USB version 2.0

665346-001

 For use only with computer models equipped with an Intel dual core processor, the
HD6490 graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665347-001

 For use only with computer models equipped with an Intel dual core processor, the
HD6490 graphics subsystem with 1024-MB of discrete memory, and USB version 2.0

665345-001

 For use only with computer models equipped with an Intel quad core processor, a
graphics subsystem with UMA memory, and USB version 3.0

665352-001

 For use only with computer models equipped with an Intel quad core processor, a
graphics subsystem with UMA memory, and USB version 2.0

665350-001

 For use only with computer models equipped with an Intel dual core processor, a
graphics subsystem with UMA memory, and USB version 3.0

665351-001

 For use only with computer models equipped with an Intel dual core processor, a
graphics subsystem with UMA memory, and USB version 2.0

665349-001

 Thermal Material Kit (not illustrated, includes replacement thermal paste and pads)

 For use only with computer models equipped with an AMD processor and a graphics
subsystem with discrete memory

665286-001

 For use only with computer models equipped with an AMD processor and a graphics
subsystem with UMA memory

665285-001
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 For use only with computer models equipped with an Intel processor and a graphics
subsystem with 2048-MB discrete memory

665354-001

 For use only with computer models equipped with an Intel processor and a graphics
subsystem with 1024-MB discrete memory

665355-001

 For use only with computer models equipped with an Intel processor and a graphics
subsystem with UMA memory

665353-001

(14) Processor (includes replacement thermal material)

 AMD A8-3530MX 2.60-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, quad core,
45 W)

653364-001

 AMD A8-3510MX 2.50-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core,
45 W)

653358-001

 AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core,
35 W)

653350-001

 AMD A6-3410MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core,
45 W)

653357-001

 AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core,
35 W)

653349-001

 AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core,
45 W)

653356-001

 AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core,
35 W)

653348-001

 Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz
FSB, 8.0-MB L3 cache, dual core, 45 W)

666175-001

 Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz
FSB, 8.0-MB L3 cache, quad core, 45 W)

634694-001

 Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz
FSB, 6.0-MB L3 cache, dual core, 45 W)

666174-001

 Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB
L3 cache, quad core, 45 W)

631254-001

 Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz
FSB, 6.0-MB L3 cache, dual core, 45 W)

665116-001

 Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB,
4.0-MB L3 cache, dual core, 35 W)

666173-001

 Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1333-MHz
FSB, 6.0-MB L3 cache, quad core, 45 W)

635501-001

 Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB
L3 cache, dual core, 35 W)

631252-001

 Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB
L3 cache, dual core, 35 W)

631255-001

 Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB
L3 cache, dual core, 35 W)

631253-001
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 Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3
cache, dual core, 35 W)

653341-001

 Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653340-001

 Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653339-001

 Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W) 664662-001

 Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W) 653338-001

(15) Fan/heat sink assembly (includes replacement thermal material):

 For use only with computer models equipped with an AMD processor and a graphics
subsystem with discrete memory

665278-001

 For use only with computer models equipped with an AMD processor and a graphics
subsystem with UMA memory

665277-001

 For use only with computer models equipped with an Intel processor and a graphics
subsystem with 2048-MB discrete memory

665309-001

 For use only with computer models equipped with an Intel processor and a graphics
subsystem with 1024-MB discrete memory

665308-001

 For use only with computer models equipped with an Intel processor and a graphics
subsystem with UMA memory

665307-001

(16) Base enclosure (includes battery release latch and 4 rubber feet)

 For use only with computer models equipped with USB version 3.0 665298-001

 For use only with computer models equipped with USB version 2.0 665297-001

(17) Battery:

 9-cell, 100-Whr, 3.00-Ah Li-ion battery 636631-001

 6-cell, 62-Whr, 2.80-Ah Li-ion battery 593562-001

 6-cell, 55-Whr, 2.55-Ah Li-ion battery 593554-001

(18) Memory modules (2, DDR3, 10600, 1333-MHz):

 8 GB 634091-001

 4 GB 621569-001

 2 GB 621565-001

(19) RTC battery 651038-001

(20) Hard drive (2.5-in, SATA, does not include hard drive bracket, hard drive connector cable, or screws):

 1-TB, 5400-rpm, 12.7 mm 638974-001

 750-GB, 7200-rpm, 9.5 mm 633252-001

 750-GB, 5400-rpm, 9.5 mm 634250-001

 640-GB, 5400-rpm, 9.5 mm 603785-001

 500-GB, 7200-rpm, 9.5 mm 608218-001
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 500-GB, 7200-rpm, 9.5 mm 634932-001

 320-GB, 7200-rpm, 7.0 mm 634862-001

 320-GB, 5400-rpm, 7.0 mm 645193-001

 160-GB solid-state drive (not illustrated, for use only with computer models
equipped with an Intel processor)

666441-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws) 665311-001

(21) WLAN module:

 For use on all computer models:

 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

 Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo
Adapter (Bluetooth 3.0+HS ready)

600370-001

 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

657325-001

 Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter 630703-001

 Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter 640926-001

 For use only with computer models equipped with an AMD processor:

 Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo
Adapter (BT3.0+HS ready)

593127-001

 For use only with computer models equipped with an Intel processor:

 Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter 593836-001

 Intel Centrino Advanced-N 6230 WLAN module 631956-001

 Intel Centrino Wireless-N 1000 WLAN module 593530-001

 Intel Centrino Wireless-N + WiMAX 6150 WLAN module 633817-001

 Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

630705-001

(22) Optical drive (includes bezel and bracket):

 Blu-ray Disc ROM FX SuperMulti DVD±R/RW Double-Layer Drive 665329-001

 Blu-ray Disc R/RW FX SuperMulti Drive 665328-001

 DVD±RW Double-Layer FX SuperMulti Drive 665327-001

(23) Service cover — available in the Plastics Kit, spare part number 665332-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 665301-001

(1) Optical drive connector cable

(2) Hard drive connector cable

(3) Fingerprint reader board cable

(4) USB board cable

(5) TouchPad cable

(6) TouchPad button board cable

(7) Power button board cable
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Display assembly subcomponents

Item Component Spare part number

(1) Display hinge covers (2) 665314-001

(2) Display bezel:

 For use only with computer models in dark umber and steel gray finish 665300-001

 For use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish

665299-001

 Display bezel and panel combination spare part kit:

 15.6-in, FHD, LED, AntiGlare, SVA display panel with display bezel 668279-001

 15.6-in, HD, LED, BrightView, SVA display panel with display bezel in aluminum finish 668280-001

 15.6-in, HD, LED, BrightView, SVA display panel with display bezel 668278-001

(3) Display Hinge Kit (includes left and right display hinges and brackets) 665313-001

(4) Display panel:

 15.6-in, FHD, LED, AntiGlare display panel 665335-001

 15.6-in, HD, LED, BrightView display panel 665334-001

(5) Display Cable Kit (includes display panel cable and webcamera/microphone module cable)

 For use only with computer models equipped with a FHD display assembly 665305-001

 For use only with computer models in dark umber and steel gray finish 665304-001

 For use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish

665302-001
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(6) Webcamera/microphone module 665365-001

(7) Antenna Kit (includes left and right wireless antenna cables and transceivers) 665287-001

(8) Display enclosure:

 In butter gold finish 665296-001

 In dark umber finish 665288-001

 In espresso black finish 665290-001

 In linen white finish 665291-001

 In Pacific blue finish 665292-001

 In pearl pink finish 665295-001

 In ruby red finish 665294-001

 In Sonoma red finish 665293-001

 In steel gray finish 665289-001

 Display Rubber Kit (not illustrated) 665337-001

 Display Screw Kit (not illustrated) 665339-001
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Mass storage devices

Item Component Spare part number

(1) Hard drive (2.5-in, SATA, does not include hard drive bracket, hard drive connector cable, or screws):

 1-TB, 5400-rpm, 12.7 mm 638974-001

 750-GB, 7200-rpm, 9.5 mm 633252-001

 750-GB, 5400-rpm, 9.5 mm 634250-001

 640-GB, 5400-rpm, 9.5 mm 603785-001

 500-GB, 7200-rpm, 9.5 mm 608218-001

 500-GB, 7200-rpm, 9.5 mm 634932-001

 320-GB, 7200-rpm, 7.0 mm 634862-001

 320-GB, 5400-rpm, 7.0 mm 645193-001

 Hard Drive Hardware Kit, includes: 665311-001

(2) Hard drive bracket

 Hard drive screws (not illustrated)
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(3) 160-GB solid-state drive (for use only with computer models equipped with an
Intel processor)

641825-001

(4) Optical drive (includes bezel and bracket):

 Blu-ray Disc ROM FX SuperMulti DVD±R/RW Double-Layer Drive 665329-001

 Blu-ray Disc R/RW FX SuperMulti Drive 665328-001

 DVD±RW Double-Layer FX SuperMulti Drive 665327-001

Miscellaneous parts

Component Spare part number

HP Smart AC adapter:

For use with all computer models:

120-W PFC RC V HP Smart AC adapter 609941-001

90-W PFC RC V HP Smart AC adapter 609940-001

65-W RC V HP Smart AC adapter 609939-001

For use only with computer models equipped with an Intel processor:

90-W PFC RC V EM HP Smart AC adapter 609947-001

65-W RC V EM HP Smart AC adapter 609948-001

Power cord (3-pin, black, 1.83-m):

For use with all computer models:

For use in Argentina 490371-D01

For use in Denmark 490371-081

For use in Europe 490371-021

For use in Italy 490371-061

For use in North America 490371-001

For use in South Africa 490371-AR1

For use in Switzerland 490371-111

For use in the United Kingdom and Singapore 490371-031

For use only with computer models equipped with AMD processors in Brazil 490371-202

For use only with computer models equipped with Intel processors:

For use in Australia 490371-111

For use in India 490371-D61
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For use in Israel 490371-BB1

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Korea 490371-AD1

For use in Taiwan 490371-AB1

For use in Thailand 490371-281

Remote control (full-function, with teletext) 465541-004

USB DVD-T antenna 581223-001

USB DVB-T TV tuner 581222-001

Screw Kit 665338-001

Sequential part number listing

Spare part number Description

465541-004 Remote control (full-function, with teletext)

490371-001 Power cord for use with all computer models in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use with all computer models in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use with all computer models in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use with all computer models in the United Kingdom and Singapore (3-pin, black,
1.83-m)

490371-061 Power cord for use with all computer models in Italy (3-pin, black, 1.83-m)

490371-081 Power cord for use with all computer models in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use with all computer models in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use only with computer models equipped with an Intel processor in Thailand (3-
pin, black, 1.83-m)

490371-202 Power cord for use with all computer models in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use with all computer models in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use only with computer models equipped with an Intel processor in the People's
Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use only with computer models equipped with an Intel processor in Taiwan (3-pin,
black, 1.83-m)

490371-AD1 Power cord for use only with computer models equipped with an Intel processor in South Korea
(3-pin, black, 1.83-m)

490371-AR1 Power cord for use with all computer models in South Africa (3-pin, black, 1.83-m)
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Spare part number Description

490371-BB1 Power cord for use only with computer models equipped with an Intel processor in Israel (3-pin,
black, 1.83-m)

490371-D01 Power cord for use with all computer models in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use only with computer models equipped with an Intel processor in India (3-pin,
black, 1.83-m)

581222-001 USB DVB-T TV tuner

581223-001 USB DVD-T antenna

593127-001 Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

593530-001 Intel Centrino Wireless-N 1000 WLAN module for use only on computer models equipped with
an Intel processor

593554-001 6-cell, 55-Whr, 2.55-Ah Li-ion battery

593562-001 6-cell, 62-Whr, 2.80-Ah Li-ion battery

593836-001 Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter for use only on computer models equipped
with an Intel processor

600370-001 Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use with all computer models

603785-001 640-GB, 5400-rpm, 9.5-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

608218-001 500-GB, 7200-rpm, 9.5-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

609939-001 65-W RC V HP Smart AC adapter for use with all computer models

609940-001 90-W PFC RC V HP Smart AC adapter for use with all computer models

609941-001 120-W PFC RC V HP Smart AC adapter for use with all computer models

609947-001 90-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

609948-001 65-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

621565-001 2-GB memory module (DDR3, 10600, 1333-MHz)

621569-001 4-GB memory module (DDR3, 10600, 1333-MHz)

630703-001 Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter for use with all computer models

630705-001 Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use only on computer models equipped with an Intel processor

631252-001 Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

631253-001 Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)
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631254-001 Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB L3 cache,
quad core, 45 W; includes replacement thermal material)

631255-001 Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

631956-001 Intel Centrino Advanced-N 6230 WLAN module for use only on computer models equipped with
an Intel processor

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

633817-001 Intel Centrino Wireless-N + WiMAX 6150 WLAN module for use only with computer models
equipped with an Intel processor

634091-001 8-GB memory module (DDR3, 10600, 1333-MHz)

634250-001 750-GB, 5400-rpm, 9.5-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

634694-001 Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz FSB, 8.0-MB
L3 cache, quad core, 45 W; includes replacement thermal material)

634862-001 320-GB, 7200-rpm, 7.0-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

634932-001 500-GB, 5400-rpm, 7.0-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

635501-001 Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1333-MHz FSB, 6.0-MB
L3 cache, quad core, 45 W; includes replacement thermal material)

636631-001 9-cell, 100-Whr, 3.00-Ah Li-ion battery

638974-001 1-TB, 5400-rpm, 12.7-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

640926-001 Realtek 8188GN 802.11b/g/n 1×1 WiFi Adapter for use with all computer models

645193-001 320-GB, 5400-rpm, 7.0-mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

651038-001 RTC battery

653338-001 Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653339-001 Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653340-001 Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653341-001 Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

653348-001 AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653349-001 AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)
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653350-001 AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

653356-001 AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core, 45 W;
includes replacement thermal material)

653357-001 AMD A6-3410MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

653358-001 AMD A8-3510MX 2.50-GHz processor (1.80-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

653364-001 AMD A8-3530MX 2.60-GHz processor, (1.90-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

655792-001 4.0 EDR Bluetooth module (for use only with computer models equipped with an Intel processor)

NOTE: The Bluetooth module spare part kit does not include the Bluetooth module cable. The
Bluetooth module cable is available using spare part number 665303-001.

655795-001 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter for use with
all computer models

657325-001 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter for use
with all computer models

664662-001 Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

665116-001 Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 6.0-MB
L3 cache, dual core, 45 W; includes replacement thermal material)

665277-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and
a graphics subsystem with UMA memory (includes replacement thermal material)

665278-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and
a graphics subsystem with discrete memory (includes replacement thermal material)

665279-001 System board for use only with computer models equipped with an AMD A60M processor and a
graphics subsystem with UMA memory (includes replacement thermal material)

665280-001 System board for use only with computer models equipped with an AMD A60M processor and a
graphics subsystem with 512-MB discrete memory (includes replacement thermal material)

665281-001 System board for use only with computer models equipped with an AMD A60M processor and a
graphics subsystem with 1024-MB discrete memory (includes replacement thermal material)

665282-001 System board for use only with computer models equipped with an AMD A70M processor and a
graphics subsystem with UMA memory (includes replacement thermal material)

665284-001 System board for use only with computer models equipped with an AMD A70M processor and a
graphics subsystem with 1024-MB discrete memory (includes replacement thermal material)

665285-001 Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory (includes replacement thermal paste and pads)

665286-001 Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory (includes replacement thermal paste and pads)

665287-001 Antenna Kit (includes left and right wireless antenna cables and transceivers)

665288-001 Display enclosure in dark umber finish
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665289-001 Display enclosure in steel gray finish

665290-001 Display enclosure in espresso black finish

665291-001 Display enclosure in linen white finish

665292-001 Display enclosure in Pacific blue finish

665293-001 Display enclosure in Sonora red finish

665294-001 Display enclosure in ruby red finish

665295-001 Display enclosure in pearl pink finish

665296-001 Display enclosure in butter gold finish

665297-001 Base enclosure for use with computer models equipped with USB version 2.0 (includes battery
release latch and 4 rubber feet)

665298-001 Base enclosure for use with computer models equipped with USB version 3.0 (includes battery
release latch and 4 rubber feet)

665299-001 Display bezel for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish and equipped with a webcamera/
microphone module

665300-001 Display bezel for use only with computer models in dark umber and steel gray finish and
equipped with a webcamera/microphone module

665301-001 Cable Kit (includes the optical drive connector cable, hard drive connector cable, power button
board cable, fingerprint reader board cable, TouchPad cable, TouchPad button board cable, and
USB board cable)

665302-001 Display Cable Kit for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish (includes display panel cable and
webcamera/microphone module cable)

665303-001 Bluetooth module cable (for use only with computer models equipped with an Intel processor)

665304-001 Display Cable Kit for use only with computer models equipped with an HD display assembly
(includes display panel cable and webcamera/microphone module cable)

665305-001 Display Cable Kit for use only with computer models equipped with an FHD display assembly
(includes display panel cable and webcamera/microphone module cable)

665306-001 Power connector cable

665307-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with UMA memory (includes replacement thermal material)

665308-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with 1024-MB of discrete memory (includes replacement thermal material)

665309-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with 2048-MB of discrete memory (includes replacement thermal material)

665310-001 Fingerprint reader board (select models only, includes bracket, but does not include cable)

NOTE: The fingerprint reader board cable is not included in the fingerprint reader board spare
part kit. The fingerprint reader board cable is included in the Cable Kit, spare part number
665301-001.
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665311-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

665313-001 Display Hinge Kit (includes left and right display hinges and brackets)

665314-001 Display hinge covers (2)

665326-001 Keyboard in black finish for use in the United States (includes keyboard cable)

665326-031 Keyboard in black finish for use in the United Kingdom and Singapore (includes keyboard cable)

665326-041 Keyboard in black finish for use in Germany (includes keyboard cable)

665326-051 Keyboard in black finish for use in France (includes keyboard cable)

665326-061 Keyboard in black finish for use in Italy (includes keyboard cable)

665326-071 Keyboard in black finish for use in Spain (includes keyboard cable)

665326-121 Keyboard in black finish for use in Canada (includes keyboard cable)

665326-131 Keyboard in black finish for use in Portugal (includes keyboard cable)

665326-141 Keyboard in black finish for use in Turkey (includes keyboard cable)

665326-161 Keyboard in black finish for use in Latin America (includes keyboard cable)

665326-171 Keyboard in black finish for use in Saudi Arabia (includes keyboard cable)

665326-201 Keyboard in black finish for use in Brazil (includes keyboard cable)

665326-211 Keyboard in black finish for use in Hungary (includes keyboard cable)

665326-251 Keyboard in black finish for use in Russia (includes keyboard cable)

665326-261 Keyboard in black finish for use only on computer models equipped with an AMD processor
in Bulgaria (includes keyboard cable)

665326-281 Keyboard in black finish for use only on computer models equipped with an Intel processor
in Thailand (includes keyboard cable)

665326-291 Keyboard in black finish for use in Japan (includes keyboard cable)

665326-A41 Keyboard in black finish for use in Belgium (includes keyboard cable)

665326-AB1 Keyboard in black finish for use only on computer models equipped with an Intel processor
in Taiwan (includes keyboard cable)

665326-AD1 Keyboard in black finish for use only on computer models equipped with an Intel processor
in South Korea (includes keyboard cable)

665326-B31 Keyboard in black finish for use in the Netherlands (includes keyboard cable)

665326-BA1 Keyboard in black finish for use in Slovenia (includes keyboard cable)

665326-BB1 Keyboard in black finish for use only on computer models equipped with an Intel processor
in Israel (includes keyboard cable)

665326-BG1 Keyboard in black finish for use in Switzerland (includes keyboard cable)

665326-D61 Keyboard in black finish for use only on computer models equipped with an Intel processor
in India (includes keyboard cable)

665326-DH1 Keyboard in black finish for use in Denmark, Finland, and Norway (includes keyboard cable)
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665326-DJ1 Keyboard in black finish for use in Slovakia (includes keyboard cable)

665326-FL1 Keyboard in black finish for use in the Czech Republic and Slovenia (includes keyboard cable)

665327-001 DVD±RW Double-Layer FX SuperMulti Drive

665328-001 Blu-ray Disc R/RW FX SuperMulti Drive

665329-001 Blu-ray Disc ROM FX SuperMulti DVD±R/RW Double-Layer Drive

665330-001 Power button board (does not include cable)

NOTE: The power button board cable is not included in the power button board spare part kit.
The power button board cable is included in the Cable Kit, spare part number 665301-001.

665331-001 USB board (does not include cable)

NOTE: The USB board cable is not included in the USB board spare part kit. The USB board
cable is included in the Cable Kit, spare part number 665301-001.

665332-001 Plastics Kit (includes the service cover)

665333-001 Speaker cover

665334-001 15.6-in, HD, LED, BrightView, SVA display panel

665335-001 15.6-in, FHD, LED, AntiGlare, SVA display panel

665337-001 Display Rubber Kit

665338-001 Screw Kit

665339-001 Display Screw Kit

665340-001 Speaker Kit (includes left and right speakers and cable)

665341-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, the HD6770 graphics subsystem with discrete memory, and USB version 3.0
(includes 2048-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665342-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, the HD6770 graphics subsystem with discrete memory, and USB version 3.0
(includes 2048-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665343-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, the HD6770 graphics subsystem with discrete memory, and USB version 3.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665344-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, the HD6770 graphics subsystem with discrete memory, and USB version 3.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665345-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, the HD6490 graphics subsystem with discrete memory, and USB version 3.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)
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665346-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, the HD6490 graphics subsystem with discrete memory, and USB version 2.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665347-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, the HD6490 graphics subsystem with discrete memory, and USB version 3.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665348-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, the HD6490 graphics subsystem with discrete memory, and USB version 3.0
(includes 1024-MB of discrete graphics subsystem memory; includes replacement
thermal material)

665349-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, a graphics subsystem with UMA memory, and USB version 2.0 (includes
replacement thermal material)

665350-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, a graphics subsystem with UMA memory, and USB version 2.0 (includes
replacement thermal material)

665351-001 System board for use only with computer models equipped with an Intel dual core processor, the
HM65 chipset, a graphics subsystem with UMA memory, and USB version 3.0 (includes
replacement thermal material)

665352-001 System board for use only with computer models equipped with an Intel quad core processor, the
HM65 chipset, a graphics subsystem with UMA memory, and USB version 3.0 (includes
replacement thermal material)

665353-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory (includes replacement thermal paste and pads)

665354-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB discrete memory (includes replacement thermal paste
and pads)

665355-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB discrete memory (includes replacement thermal paste
and pads)

665356-001 Top cover in dark umber finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665357-001 Top cover in steel grey finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665358-001 Top cover in espresso black finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.
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665359-001 Top cover in linen white finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665360-001 Top cover in Pacific blue finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665361-001 Top cover in Sonora red finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665362-001 Top cover in ruby red finish (includes TouchPad and TouchPad button board, but does not include
TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665363-001 Top cover in pearl pink finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665364-001 Top cover in butter gold finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 665301-001.

665365-001 Webcamera/microphone module

666173-001 Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB, 4.0-MB L3
cache, dual core, 35 W; includes replacement thermal material)

666174-001 Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB
L3 cache, dual core, 45 W; includes replacement thermal material)

666175-001 Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 8.0-MB
L3 cache, dual core, 45 W; includes replacement thermal material)

666423-001 Keyboard in silver finish for use in the United States (includes keyboard cable)

666423-031 Keyboard in silver finish for use in the United Kingdom and Singapore (includes keyboard cable)

666423-041 Keyboard in silver finish for use in Germany (includes keyboard cable)

666423-051 Keyboard in silver finish for use in France (includes keyboard cable)

666423-061 Keyboard in silver finish for use in Italy (includes keyboard cable)

666423-071 Keyboard in silver finish for use in Spain (includes keyboard cable)

666423-121 Keyboard in silver finish for use in Canada (includes keyboard cable)

666423-131 Keyboard in silver finish for use in Portugal (includes keyboard cable)
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666423-141 Keyboard in silver finish for use in Turkey (includes keyboard cable)

666423-161 Keyboard in silver finish for use in Latin America (includes keyboard cable)

666423-171 Keyboard in silver finish for use in Saudi Arabia (includes keyboard cable)

666423-201 Keyboard in silver finish for use in Brazil (includes keyboard cable)

666423-211 Keyboard in silver finish for use in Hungary (includes keyboard cable)

666423-251 Keyboard in silver finish for use in Russia (includes keyboard cable)

666423-261 Keyboard in silver finish for use only on computer models equipped with an AMD processor
in Bulgaria (includes keyboard cable)

666423-281 Keyboard in silver finish for use only on computer models equipped with an Intel processor
in Thailand (includes keyboard cable)

666423-291 Keyboard in silver finish for use in Japan (includes keyboard cable)

666423-A41 Keyboard in silver finish for use in Belgium (includes keyboard cable)

666423-AB1 Keyboard in silver finish for use only on computer models equipped with an Intel processor
in Taiwan (includes keyboard cable)

666423-AD1 Keyboard in silver finish for use only on computer models equipped with an Intel processor
in South Korea (includes keyboard cable)

666423-B31 Keyboard in silver finish for use in the Netherlands (includes keyboard cable)

666423-BA1 Keyboard in silver finish for use in Slovenia (includes keyboard cable)

666423-BB1 Keyboard in silver finish for use only on computer models equipped with an Intel processor
in Israel (includes keyboard cable)

666423-BG1 Keyboard in silver finish for use in Switzerland (includes keyboard cable)

666423-D61 Keyboard in silver finish for use only on computer models equipped with an Intel processor
in India (includes keyboard cable)

666423-DH1 Keyboard in silver finish for use in Denmark, Finland, and Norway (includes keyboard cable)

666423-DJ1 Keyboard in silver finish for use in Slovakia (includes keyboard cable)

666423-FL1 Keyboard in silver finish for use in the Czech Republic and Slovenia (includes keyboard cable)

666441-001 160-GB solid-state drive (for use only with computer models equipped with an Intel processor)

668278-001 15.6-in, HD, LED, BrightView, SVA display panel with display bezel

668279-001 15.6-in, FHD, LED, AntiGlare, SVA display panel with display bezel

668280-001 15.6-in, HD, LED, BrightView, SVA display panel with display bezel in aluminum finish
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 88 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw and screw lock size and location during removal
and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

the computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the
base enclosure in the locations illustrated below.
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Battery

Description Spare part number

9-cell, 100-Whr, 3.00-Ah Li-ion battery 636631-001

6-cell, 62-Whr, 2.80-Ah Li-ion battery 593562-001

6-cell, 55-Whr, 2.55-Ah Li-ion battery 593554-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Slide the battery release latch (1) to release the battery.

2. Pivot the front edge of the battery (2) up and back.

3. Remove the battery (3) from the computer.
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To insert the battery:

1. Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery bay.

2. Pivot the front edge of the battery down into the battery bay until it is seated. (The battery release
latch will automatically lock into place.)

Optical drive

NOTE: The optical drive spare part kit includes a bezel and bracket.

Description Spare part number

Blu-ray Disc ROM FX SuperMulti DVD±R/RW Double-Layer Drive 665329-001

Blu-ray Disc R/RW FX SuperMulti Drive 665328-001

DVD±RW Double-Layer FX SuperMulti Drive 665327-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

Remove the optical drive:

1. Slide the service cover release latch to release the service cover.
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2. Lift the rear edge of the service cover up and forward until it rests at an angle.

3. Remove the service cover. The service cover is available in the Plastics Kit, spare part number
665332-001.

4. Remove the Phillips PM2.5×4.0 screw that secures the optical drive to the computer.

5. Remove the optical drive by sliding it out of the optical drive bay.

6. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.
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7. Remove the two Phillips PM2.0×4.0 screws (1) that secure the bracket to the optical drive.

8. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Hard drive

NOTE: The hard drive and solid-state drive spare part kit does not include the bracket, connector
cable, or screws. The bracket and screws are included in the Hard Drive Hardware Kit, spare part
number 665311-001. The connector cable is included in the Cable Kit, spare part number
665301-001.

Description Spare part number

1-TB, 5400-rpm, 12.7 mm 638974-001

750-GB, 7200-rpm, 9.5 mm 633252-001

750-GB, 5400-rpm, 9.5 mm 634250-001

640-GB, 5400-rpm, 9.5 mm 603785-001

500-GB, 7200-rpm, 9.5 mm 608218-001

500-GB, 7200-rpm, 9.5 mm 634932-001

320-GB, 7200-rpm, 7.0 mm 634862-001

320-GB, 5400-rpm, 7.0 mm 645193-001

160-GB solid-state drive 666441-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service cover (see Optical drive on page 52).

Remove the hard drive:

1. Disconnect the hard drive connector cable (1) from the system board.

2. Remove the four Phillips PM2.5×4.0 screws (2) that secure the hard drive to the computer.

3. Use the Mylar tab built into the hard drive bracket to lift and remove the hard drive (3) from
the computer.

4. If it is necessary to replace the hard drive connector cable or hard drive bracket:

a. Remove the four Phillips PM3.0×4.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive.
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c. Disconnect the hard drive connector cable (3) from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

56 Chapter 4   Removal and replacement procedures



RTC battery

Description Spare part number

RTC battery 651038-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service cover (see Optical drive on page 52).

Remove the RTC battery:

▲ Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.

Component replacement procedures 57



Memory module

Description Spare part number

8-GB (DDR3, 10600, 1333-MHz) 634091-001

4-GB (DDR3, 10600, 1333-MHz) 621569-001

2-GB (DDR3, 10600, 1333-MHz) 621565-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service cover (see Optical drive on page 52).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.
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WLAN module

Description Spare part number

For use on all computer models:

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

600370-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter 630703-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter 640926-001

For use only with computer models equipped with an AMD processor:

Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

593127-001

For use only with computer models equipped with an Intel processor:

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter 593836-001

Intel Centrino Advanced-N 6230 WLAN module 631956-001

Intel Centrino Wireless-N 1000 WLAN module 593530-001

Intel Centrino Wireless-N + WiMAX 6150 WLAN module 633817-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

630705-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service cover (see Optical drive on page 52).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables from the terminals on the WLAN module.

NOTE: The #1/black WLAN antenna cable is connected to the WLAN module Main terminal.
The #2/gray WLAN antenna cable is connected to the WLAN module Aux terminal.

2. Remove the two Phillips PM2.0×4.0 screws that secure the WLAN module to the system board.
(The WLAN module tilts up.)

3. Remove the WLAN module by pulling the module away from the slot at an angle.
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NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Keyboard

NOTE: The keyboard spare part kit includes a keyboard cable.

Description Spare part number Description Spare part number

Keyboard in black finish:

For use with all computer models
in Belgium

665326-A41 For use with all computer models
in Latin America

665326-161

For use with all computer models
in Brazil

665326-201 For use with all computer models
in the Netherlands

665326-B31

For use only with computer models
equipped with an AMD processor
in Bulgaria

665326-261 For use with all computer models
in Portugal

665326-131

For use with all computer models
in Canada

665326-121 For use with all computer models
in Russia

665326-251

For use with all computer models
in the Czech Republic and Slovakia

665326-FL1 For use with all computer models
in Saudi Arabia

665326-171

For use with all computer models
in Denmark, Finland, and Norway

665326-DH1 For use with all computer models
in Slovenia

665326-BA1

For use with all computer models
in France

665326-051 For use only with computer models
equipped with an Intel processor
in South Korea

665326-AD1

For use with all computer models
in Germany

665326-041 For use with all computer models
in Spain

665326-071

For use with all computer models
in Greece

665326-DJ1 For use with all computer models
in Switzerland

665326-BG1

For use with all computer models
in Hungary

665326-211 For use only with computer models
equipped with an Intel processor
in Taiwan

665326-AB1

For use only with computer models
equipped with an Intel processor
in India

665326-D61 For use only with computer models
equipped with an Intel processor
in Thailand

665326-281

For use only with computer models
equipped with an Intel processor
in Israel

665326-BB1 For use with all computer models
in Turkey

665326-141

For use with all computer models
Italy

665326-061 For use with all computer models
in the United Kingdom and
Singapore

665326-031

For use with all computer models
in Japan

665326-291 For use with all computer models
in the United States

665326-001

Keyboard in silver finish:

For use with all computer models
in Belgium

666423-A41 For use with all computer models
in Latin America

666423-161
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Description Spare part number Description Spare part number

For use with all computer models
in Brazil

666423-201 For use with all computer models
in the Netherlands

666423-B31

For use only with computer models
equipped with an AMD processor
in Bulgaria

666423-261 For use with all computer models
in Portugal

666423-131

For use with all computer models
in Canada

666423-121 For use with all computer models
in Russia

666423-251

For use with all computer models
in the Czech Republic and Slovakia

666423-FL1 For use with all computer models
in Saudi Arabia

666423-171

For use with all computer models
in Denmark, Finland, and Norway

666423-DH1 For use with all computer models
in Slovenia

666423-BA1

For use with all computer models
in France

666423-051 For use only with computer models
equipped with an Intel processor
in South Korea

666423-AD1

For use with all computer models
in Germany

666423-041 For use with all computer models
in Spain

666423-071

For use with all computer models
in Greece

666423-DJ1 For use with all computer models
in Switzerland

666423-BG1

For use with all computer models
in Hungary

666423-211 For use only with computer models
equipped with an Intel processor
in Taiwan

666423-AB1

For use only with computer models
equipped with an Intel processor
in India

666423-D61 For use only with computer models
equipped with an Intel processor
in Thailand

666423-281

For use only with computer models
equipped with an Intel processor
in Israel

666423-BB1 For use with all computer models
in Turkey

666423-141

For use with all computer models
Italy

666423-061 For use with all computer models
in the United Kingdom and
Singapore

666423-031

For use with all computer models
in Japan

666423-291 For use with all computer models
in the United States

666423-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51).

5. Remove the service cover (see Optical drive on page 52).
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Remove the keyboard:

1. Remove the Phillips PM2.5×4.0 screw that secures the keyboard to the computer.

2. Rest the computer on its left side.

3. Open the computer.

4. Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.
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6. Lift the rear edge (1) of the keyboard, and then slide the keyboard (2) back until the keyboard
cable is accessible.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.

Component replacement procedures 65



Top cover

NOTE: The top cover spare part kit includes the TouchPad and TouchPad button board, but does not
include the TouchPad cable or TouchPad button board cable. The TouchPad cable and TouchPad
button board cable are included in the Cable Kit, spare part number 665301-001.

Description Spare part number

In butter gold finish 665364-001

In dark umber finish 665356-001

In espresso black finish 665358-001

In linen white finish 665359-001

In Pacific blue finish 665360-001

In pearl pink finish 665363-001

In ruby red finish 665362-001

In Sonoma red finish 665361-001

In steel gray finish 665357-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

NOTE: When replacing the top cover, be sure that the power button board and cable (see Power
button board on page 69) and fingerprint reader board and cable (see Fingerprint reader board
on page 70) are removed from the defective top cover and installed on the replacement top cover.

Remove the top cover:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Remove the seven Phillips PM2.5×10.0 screws that secure the top cover to the computer.

4. Remove the following screws that secure the top cover to the computer:

● Three Phillips PM2.0×3.0 screws (1) in the optical drive bay

● Three Phillips PM2.5×6.0 screws (2)

● One Phillips PM2.0×4.0 screw (3) in the hard drive bay

5. Turn the computer right-side up, with the front toward you.

6. Open the computer.
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7. Release the ZIF connectors to which the following cables are attached, and then disconnect the
cables from the system board:

NOTE: The power button board cable, TouchPad button board cable, and fingerprint reader
board cable are included in the Cable Kit, spare part number 665301-001.

● Power button board cable (1)

● TouchPad button board cable (2)

● Fingerprint reader board cable (3) (select models only)

8. Remove the seven Phillips PM2.5×6.0 screws that secure the top cover to the computer.

9. Lift the rear edge of the top cover (1) until the left and right sides disengage from the
base enclosure.
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10. Remove the top cover (2).

Reverse this procedure to install the top cover.

Power button board

Description Spare part number

Power button board (does not include cable)

NOTE: The power button board cable is not included in the power button board spare part kit. The
power button board cable is included in the Cable Kit, spare part number 665301-001.

665330-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.

2. Release the power button board cable from the clip (1) built into the top cover.
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3. Remove the three Phillips PM2.0×4.0 screws (2) that secure the power button board to the
top cover.

4. Remove the power button board and cable (3).

Reverse this procedure to install the power button board and cable.

Fingerprint reader board

Description Spare part number

Fingerprint reader board (select models only, includes bracket, but does not include cable)

NOTE: The fingerprint reader board cable is not included in the fingerprint reader board spare
part kit. The fingerprint reader board cable is included in the Cable Kit, spare part number
665301-001.

665330-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)
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● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

Remove the fingerprint reader board and cable:

1. Turn the top cover upside down, with the front toward you.

2. Release the fingerprint reader board cable (1) from the clips (2) built into the top cover.

3. Remove the two Phillips PM2.0×4.0 screws (3) that secure the fingerprint reader board and
bracket to the top cover.

4. Remove the fingerprint reader board bracket (4) and the fingerprint reader board (5).

Reverse this procedure to install the fingerprint reader board and cable.
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Bluetooth module

NOTE: This section applies only to computer models equipped with an Intel processor.

Description Spare part number

EDR v.4.0 Bluetooth module 655792-001

NOTE: The Bluetooth module spare part kit does not include the Bluetooth module cable. The Bluetooth module cable is
available using spare part number 665303-001.

Before removing the Bluetooth module and cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

Remove the Bluetooth module and cable:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module cable from the clips (2) and the routing channel built into the front
speaker assembly.
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3. Release the Bluetooth module (3) from the clip built into the front speaker assembly.

4. Remove the Bluetooth module and the Bluetooth module cable.

5. If it is necessary to replace the Bluetooth module cable, disconnect the cable from the Bluetooth
module and replace it.

Reverse this procedure to install the Bluetooth module and cable.
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USB board

Description Spare part number

USB board (does not include cable)

NOTE: The USB board cable is not included in the USB board spare part kit. The USB board cable
is included in the Cable Kit, spare part number 665303-001.

665331-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

Remove the USB board and cable:

1. Release the ZIF connector to which the USB board cable is connected, and then disconnect the
USB board cable (1) from the system board.

2. Remove the Phillips PM2.5×5.0 screw (2) that secures the USB board to the base enclosure.

3. Remove the USB board (3) and cable.
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Reverse this procedure to install the USB board.

Power connector cable

Description Spare part number

Power connector cable 665306-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

● USB board (see USB board on page 74)

Remove the power connector cable:

1. Disconnect the power connector cable (1) from the system board.

2. Release the power connector cable from the clips (2) built into the base enclosure.

3. Remove the two Phillips PM2.0×2.0 screws (3) that secure the power connector to the
base enclosure.
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4. Remove the power connector (4) from the base enclosure.

Reverse this procedure to install the power connector cable.
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System board

NOTE: The system board spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

● 665286-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

● 665285-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

● 665354-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB discrete memory

● 665355-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB discrete memory

● 665353-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number

For use only with computer models equipped with an AMD A70M processor, the HD6750 graphics
subsystem with 1024-MB of discrete memory, and USB version 3.0

665284-001

For use only with computer models equipped with an AMD A70M processor, a graphics subsystem
with UMA memory, and USB version 3.0

665282-001

For use only with computer models equipped with an AMD A60M processor, the HD6750 graphics
subsystem with 1024-MB of discrete memory, and USB version 2.0

665281-001

For use only with computer models equipped with an AMD A60M processor, the HD6490 graphics
subsystem with 512-MB of discrete memory, and USB version 2.0

665280-001

For use only with computer models equipped with an AMD A60M processor, a graphics subsystem
with UMA memory, and USB version 2.0

665279-001

For use only with computer models equipped with an Intel quad core processor, the HD6770
graphics subsystem with 2048-MB of discrete memory, and USB version 3.0

665342-001

For use only with computer models equipped with an Intel dual core processor, the HD6770
graphics subsystem with 2048-MB of discrete memory, and USB version 3.0

665341-001

For use only with computer models equipped with an Intel quad core processor, the HD6770
graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665344-001

For use only with computer models equipped with an Intel dual core processor, the HD6770
graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665343-001

For use only with computer models equipped with an Intel quad core processor, the HD6490
graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665348-001

For use only with computer models equipped with an Intel quad core processor, the HD6490
graphics subsystem with 1024-MB of discrete memory, and USB version 2.0

665346-001

For use only with computer models equipped with an Intel dual core processor, the HD6490
graphics subsystem with 1024-MB of discrete memory, and USB version 3.0

665347-001
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Description Spare part number

For use only with computer models equipped with an Intel dual core processor, the HD6490
graphics subsystem with 1024-MB of discrete memory, and USB version 2.0

665345-001

For use only with computer models equipped with an Intel quad core processor, a graphics
subsystem with UMA memory, and USB version 3.0

665352-001

For use only with computer models equipped with an Intel quad core processor, a graphics
subsystem with UMA memory, and USB version 2.0

665350-001

For use only with computer models equipped with an Intel dual core processor, a graphics subsystem
with UMA memory, and USB version 3.0

665351-001

For use only with computer models equipped with an Intel dual core processor, a graphics subsystem
with UMA memory, and USB version 2.0

665349-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● WLAN module (see WLAN module on page 59)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● RTC battery (see RTC battery on page 57)

● Memory module (see Memory module on page 58)

● Fan and heat sink (see Fan/heat sink assembly on page 81)

● Processor (see Processor on page 85)

Remove the system board:

1. Close the computer.

2. Turn the computer upside down, with the font toward you.
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3. Disconnect the speaker cable (1) and the optical drive connector cable (2) from the system board.

4. Turn the computer right side up, with the front toward you.

5. Open the computer.

6. Disconnect the following cables from the system board:

● Display panel cable (1)

● Webcamera/microphone cable (2)

● Bluetooth module cable (3)

● USB board cable (4)

● Power connector cable (5)
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7. Remove the Phillips PM2.5×4.0 screw (1) and the two Phillips PM2.5×5.0 screws (2) that secure
the system board to the base enclosure.

8. Flex the left side of the base enclosure (1) outward to provide clearance for the audio
connectors (2) and the other connectors on the left side of the system board.

9. Lift the front edge of the system board (3) until it rests at an angle.

10. Remove the system board (4) by sliding it up and forward at an angle.

Reverse this procedure to install the system board.
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Fan/heat sink assembly

NOTE: The fan/heat sink assembly spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

● 665286-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

● 665285-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

● 665354-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB discrete memory

● 665355-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB discrete memory

● 665353-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number

For use only with computer models equipped with an AMD processor and a graphics subsystem with
discrete memory

665278-001

For use only with computer models equipped with an AMD processor and a graphics subsystem with
UMA memory

665277-001

For use only with computer models equipped with an Intel processor and a graphics subsystem with
2048-MB discrete memory

665309-001

For use only with computer models equipped with an Intel processor and a graphics subsystem with
1024-MB discrete memory

665308-001

For use only with computer models equipped with an Intel processor and a graphics subsystem with
UMA memory

665307-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of
the computer. the computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

Component replacement procedures 81



3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● WLAN module (see WLAN module on page 59)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

● System board (see System board on page 77)

Remove the fan/heat sink assembly:

1. Disconnect the fan cable from the system board.

2. Turn the system board upside down, with the fan away from you.

3. Loosen the captive screws (1) that secure the fan/heat sink assembly to the system board.

NOTE: The number of screws used to secure the fan/heat sink assembly to the system board
varies by computer model.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.
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4. Remove the fan/heat sink assembly (2).

NOTE: The following illustration shows the fan/heat sink assembly being removed from a
computer model equipped with an AMD processor and a graphics subsystem with
discrete memory. A computer model equipped with an AMD processor and a graphics subsystem
with UMA memory has only four screws.

NOTE: The following illustration shows the fan/heat sink assembly being removed from a
computer model equipped with an Intel processor and a graphics subsystem with discrete memory.
A computer model equipped with an Intel processor and a graphics subsystem with UMA memory
has only four screws.

Component replacement procedures 83



The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system
board components each time the fan/heat sink assembly is removed. Replacement thermal material is
included with the fan/heat sink assembly, processor, and system board spare part kits.
Replacement thermal material is also available in the Thermal Material Kit.

NOTE: The following illustration shows the replacement thermal material locations on a computer
model equipped with an AMD processor and a graphics subsystem with discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with discrete memory)

● A thermal pad is used on the Northbridge chip (5) and the heat sink section (6) that services it

NOTE: The following illustration shows the replacement thermal material locations on a computer
model equipped with an Intel processor and a graphics subsystem with discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with discrete memory)

● A thermal pad is used on the Northbridge chip (5) and the heat sink section (6) that services it
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Reverse this procedure to reassemble and install the fan/heat sink assembly.

Processor

NOTE: The processor spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

● 665286-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

● 665285-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

● 665354-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB discrete memory

● 665355-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB discrete memory

● 665353-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number

AMD A8-3530MX 2.60-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 653364-001

AMD A8-3510MX 2.50-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 653358-001

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W) 653350-001

AMD A6-3410MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core, 45 W) 653357-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W) 653349-001

AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core, 45 W) 653356-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W) 653348-001
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Description Spare part number

Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 8.0-MB L3
cache, dual core, 45 W)

666175-001

Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.20-GHz) processor (1600-MHz FSB, 8.0-MB
L3 cache, quad core, 45 W)

634694-001

Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, dual core, 45 W)

666174-001

Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB L3 cache,
quad core, 45 W)

631254-001

Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, dual core, 45 W)

665116-001

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB, 4.0-MB L3
cache, dual core, 35 W)

666173-001

Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1333-MHz FSB, 6.0-MB
L3 cache, quad core, 45 W)

635501-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB L3 cache, dual core,
35 W)

631252-001

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

631255-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

631253-001

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache, dual core,
35 W

653341-001

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653340-001

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653339-001

Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W) 664662-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W) 653338-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● WLAN module (see WLAN module on page 59)
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● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

● System board (see System board on page 77)

● Fan/heat sink assembly (see Fan/heat sink assembly on page 81)

Remove the processor:

1. Use a flat-bladed screw driver to turn the processor locking screw one-half turn
counterclockwise (1), until you hear a click.
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2. Lift the processor (2) straight up, and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

NOTE: The following illustration shows the processor removal process on a computer model
equipped with an AMD processor.

NOTE: The following illustration shows the processor removal process on a computer model
equipped with an Intel processor.

Reverse this procedure to install the processor.
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Speakers

Description Spare part number

Speaker cover 665333-001

Speaker Kit (includes left and right speakers and cable) 665340-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

● System board (see System board on page 77)

Remove the speakers:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Release the rear speaker cable (1) from the clips (2) and routing channel built into the
base enclosure.

4. Remove the four Phillips PM2.5×4.0 screws (1) and the PM2.5×10.0 screw (2) that secure the
rear speaker to the computer.

5. Turn the computer right side up, with the front toward you.

6. Open the computer.

7. Release the rear speaker cable (1) from the opening in the base enclosure and the clips (2)
and (3) built into the base enclosure.
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8. Remove the rear speaker (4) and cable.

9. Remove the Phillips PM2.5×4.0 screw (1) that secures the front speaker to the base enclosure.

10. Remove the front speaker (2).

NOTE: When removing the front speaker, note the installation locations of two isolators (3).

Reverse this procedure to install the speakers.
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Optical drive connector cable

NOTE: The optical drive connector cable is included in the Cable Kit, spare part number
665301-001. The optical drive connector cable includes the optical drive connector.

Before removing the optical drive connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● Keyboard (see Keyboard on page 62)

● Top cover (see Top cover on page 66)

● System board (see System board on page 77)

Remove the optical drive connector cable:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Release the optical drive connector cable (1) from the clips (2) and routing channel built into the
base enclosure.
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4. Turn the computer right side up, with the front toward you.

5. Open the computer.

6. Release the optical drive connector cable from the clips (1) built into the base enclosure.

7. Remove the two Phillips PM2.0×7.0 screws (1) that secure the optical drive connector to the
base enclosure.

8. Remove the optical drive connector cable (3).

Reverse this procedure to install the optical drive connector cable.

Display assembly

NOTE: The display assembly is spared at the subcomponent level only.

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 51), and then remove the following components:

● Optical drive (see Optical drive on page 52)

● Hard drive (see Hard drive on page 54)

● WLAN module (see WLAN module on page 59)

● Keyboard (see Keyboard on page 62)
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● Top cover (see Top cover on page 66)

● System board (see System board on page 77)

Remove the display assembly:

1. Release the wireless antenna cables from the clips (1) and the opening in the base enclosure.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

2. Remove the six Phillips PM2.5×5.0 screws (2) that secure the display assembly to the computer.

NOTE: The left-most screw on the left hinge secures a display panel cable ground loop (3).

3. Remove the display assembly (4).

94 Chapter 4   Removal and replacement procedures



4. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the two screw covers (1) and the two Phillips PM2.5×5.0 screws (2) that secure the
display bezel to the display assembly. (The screw covers are available in the Display Rubber
Kit, spare part number 665337-001.)

b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (4). The display bezel is available using spare part numbers
665300-001 (for use only with computer models in dark umber and steel gray finish) and
665299-001 (for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish).
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5. If it is necessary to replace the webcam/microphone module:

a. Detach and release the webcamera/microphone module (1) as far as the webcamera/
microphone module cable allows. (The webcamera/microphone module is attached to the
display enclosure with double-sided tape.)

b. Disconnect the webcamera/microphone module (2) from the webcamera/
microphone module.

c. Remove the webcamera/microphone module (3). The webcamera/microphone module is
available using spare part number 665365-001.

6. If it is necessary to replace the hinge covers:

a. Remove the two Phillips PM2.0×3.0 (1) screws that secure the hinge covers to the
display enclosure.
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b. Remove the hinge covers (2). The hinge covers are available using spare part number
665314-001.

7. If it is necessary to replace the display panel:

a. Remove the two Phillips PM2.5×3.5 (1) screws and the six Phillips PM2.5×5.0 screws (2)
that secure the display panel to the display enclosure.
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b. Lift the top edge of the display panel (1), and then swing it forward (2) until it rests upside
down in front of the display enclosure.

c. Release the adhesive strips (1) and (2) that secure the display panel cable to the display
panel, and then disconnect the display panel cable (3) from the display panel.

d. Remove the display panel. The display panel is available using spare part numbers
668279-001 and 665335-001 (for use with computer models equipped with a 15.6-in,
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FHD, LED, AntiGlare display panel) and 668280-001, 668278-001, and 665334-001 (for
use with computer models equipped with a 15.6-in, HD, LED, BrightView display panel).

8. If it is necessary to replace the display hinges:

a. Remove the eight Phillips PM2.0×2.0 screws (1) that secure the display hinges to the
display panel.

b. Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 665313-001.

9. If it is necessary to replace the display panel cable:

a. Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.
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b. Release the display panel cable from the clips (2) built into the display enclosure.

c. Remove the display panel cable. The display panel cable includes the webcamera/
microphone module cable and is available in the Display Cable Kit, using the following
spare part numbers:

● 665305-001 — For use only with computer models equipped with a FHD
display assembly

● 665304-001 — For use only with computer models in dark umber and steel gray finish

● 665302-001 — For use only with computer models in butter gold, espresso black, linen
white, Pacific blue, pearl pink, ruby red, and Sonoma red finish

10. If it is necessary to replace the wireless antenna cables and transceivers:

a. Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the wireless antenna cables from the clips (2) built into the display enclosure.
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c. Remove the wireless antenna cables and transceivers (3). The wireless antenna cables and
transceivers are available in the Antenna Kit, spare part number 665287-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer from
operating properly.

Starting Setup Utility

NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only if
USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

Changing the language of Setup Utility

1. Start Setup Utility.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Setup Utility.

2. Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

● To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information

1. Start Setup Utility.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility

● To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Windows 7—Select Start > Help and Support > Maintain.

Windows XP—Select Start > Help and Support, and then select the software and
drivers update.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Windows 7—Open Windows Explorer by selecting Start > Computer.

Windows XP—Open Windows Explorer by selecting Start > My Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact HP
support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.

To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Depth 24.7 cm 9.72 in

Width 37.8 cm 14.88 in

Height (front to back) 3.1 to 3.5 cm 1.23 to 1.39 in

Weight 2.91 kg 6.42 lb

Input power

Operating voltage 18.5 V dc @ 3.5 A – 65 W; 19 V dc @ 4.74 A – 90 W; or
18.5 V dc @ 6.5 A – 120 W

Operating current 3.5, 4.74, or 6.5 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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15.6-inch display specifications

 Metric U.S.

Dimensions

Height 19.6 cm 7.72 in

Width 34.7 cm 13.66 in

Diagonal 39.8 cm 15.67 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 1-TB* 750-GB** 640-GB**

Dimensions

Height 12.7 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.2 mm 100.2 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 152 g 110 g 98 g

Interface type SATA (3 GB/sec) SATA (3 GB/sec) SATA

Transfer rate

Synchronous (maximum) 97 MB/sec 97 MB/sec 106 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 2.0 ms 1.5 ms

Average (read/write) 12/16 ms 12/16 ms 12/13 ms

Maximum 21 ms 21 ms 24 ms

Logical blocks 1,953,525, 168 1,465,149,168 1,250,263,728

Disk rotational speed 5400 RPM 7200 and 5400 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 TB = 1 trillion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

**1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Hard drive specifications (continued)

 500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm 7.0 mm 7.0 mm

Length 100.4 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 105 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 1.5 ms

Average (read/write) 11/13 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 976,773,168 628,142,448 488,397,168

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.

This chapter provides information on the following topics:

● Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)

● Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

● Backing up your information

● Recovering a program or driver

Restore
In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash drive
immediately after software setup.

If for some other reason you need to restore your system, this can be achieved using the HP Recovery
partition (select models only), without the need for recovery discs or a recovery flash drive. To check for
the presence of a recovery partition, click Start, right-click Computer, click Manage, and then click
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.

NOTE: Recovery discs have been included if your computer does not have a recovery partition.
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Creating restore media
HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason you
cannot restore using the recovery partition tools. Create these discs or the flash drive after setting up
the computer for the first time.

NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery
flash drive. Handle these discs or flash drive carefully and keep them in a safe place.

NOTE: If your computer does not include an integrated optical drive, you can use an optional
external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be connected
directly to a USB port on the computer, not to a USB port on an external device, such as a USB hub.

Guidelines:

● Purchase high-quality DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs.

NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

● the computer must be connected to AC power during this process.

● Only one set of recovery discs or one recovery flash drive can be created per computer.

NOTE: If you are creating recovery discs, number each disc before inserting into the optical
drive.

● If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to continue
the backup creation process.

To create a set of recovery discs or a recovery flash drive:

1. Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2. Follow the on-screen instructions.
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Performing a system restore
Recovery Manager software allows you to repair or restore the computer to its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.

NOTE: A system restore needs to be performed if the computer hard drive has failed or if all attempts
to correct any functional computer issues fail.

A system restore should be used as a final attempt to correct computer issues. Note the following when
performing a system restore:

● You can restore only the system that you have previously backed up. HP recommends that you use
HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as soon as
you set up the computer.

● Windows has its own built-in repair features, such as System Restore. If you have not already tried
these features, try them before using Recovery Manager.

● Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition
(select models only)

When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.

To restore the computer from the recovery partition, follow these steps:

1. Access Recovery Manager in either of the following ways:

● Select Start > All Programs > Recovery Manager > Recovery Manager.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press f11 while the “F11
(System Recovery)” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Restoring using the restore media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical
drive, and then restart the computer.

– or –

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

NOTE: If the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3. Press f9 at system bootup.

4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:

1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.

4. Select the flash drive from the boot options window.
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Backing up and recovering your information
It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.

How completely you are able to recover your system depends on how recent your backup is.

NOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted.

You can back up your information to an optional external hard drive, a network drive, or discs. Back
up your system at the following times:

● At regularly scheduled times

TIP: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Guidelines:

● Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

● Store personal files in the Documents library and back up this folder periodically.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. the screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste. the screen image is added to
the document.

4. Save and print the document.
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Using Windows Backup and Restore

Guidelines:

● Be sure that the computer is connected to AC power before you start the backup process.

● Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points

A system restore point allows you to save and name a snapshot of your hard drive at a specific point
in time. You can then recover back to that point if you want to reverse subsequent changes.

NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your files and settings.

When to create restore points

● Before you add or modify software or hardware

● Periodically, whenever the computer is functioning optimally

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1

Japan JIS 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea KTL 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom ASTA 1
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Country/region Accredited agency Applicable note number

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark.
UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² or 1.25-mm² conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75-mm² conductor size. KTL logo and individual approval number must be
on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3×1.25-mm² conductor size. Power cord set fittings (appliance coupler, cable, and
wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL
and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3×0.75-/1.00-mm² conductor size, with
plug BS 1363/A with BSI or ASTA marks.

120 Chapter 8   Power cord set requirements



9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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